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[bookmark: _Ref72554628][bookmark: _Toc375841008][bookmark: _Toc375894207][bookmark: _Toc543481][bookmark: _Ref86643384][bookmark: _Ref86643621]Introduction
[bookmark: _Toc165351038][bookmark: _Toc375841009][bookmark: _Toc375894208][bookmark: _Toc543482]What is Chronolator and what does it do?
Chronolator makes it easy to produce the chronologies that are needed to review interactions between different agencies and organisations. Since it is based on Microsoft Word, little specialist knowledge is required to use it. There are no new programs to learn or install, and only a basic knowledge of working with Word tables is required. 
Chronolator has something to help everyone involved in using a chronology to investigate a case:
those who supervise and administer it;
the front-line staff who input the data;
those who review it.
[bookmark: _Toc375841010][bookmark: _Toc375894209][bookmark: _Toc543483]Administrators
Gathering and collating chronologies from multiple agencies is a time consuming task, particularly if they each have different ideas about what they need to provide. Chronolator enforces the standards set by the administrator (for example, what column headings the chronology table should have) and automates the merging of individual chronologies.
[bookmark: _Toc375841011][bookmark: _Toc375894210][bookmark: _Toc543484]Front-line staff
Transcribing written records from various sources into a consistent format is a tedious and error‑prone task. Chronolator simplifies the process with a number of tools. There are tools to sort records into order, to put dates into consistent formats, and to check for a variety of problems.
[bookmark: _Toc375841012][bookmark: _Toc375894211][bookmark: _Toc543485]Reviewers
The final objective of a chronology is that someone can make sense of the events it contains. Chronologies are often anonymised, which can make it difficult to build a mental picture of the people involved. The Chronolator anonymisation tool lets you switch back and forth between anonymised and personalised views of a document. 
Other tools for reviewers include:
navigating through a chronology according to entries in the Abbreviations Glossary;
reports about items and individuals identified in the Abbreviations Glossary;
colour-coding events according to the agency reporting them;
a calculator to work out the interval between two dates;
formatting a tabular chronology into a narrative layout;
an analysis tool summarising event counts by agency and date.


1.1.1 [bookmark: _Toc375841013][bookmark: _Toc375894212][bookmark: _Toc378331015][bookmark: _Toc460918888][bookmark: _Toc543486][bookmark: _Toc375841014][bookmark: _Toc375894213]The Chronolator Process
The Chronolator process begins when the Case Review Administrator sets up an Internal Chronology[footnoteRef:1], which is a Word document containing a table whose headings and other characteristics are specified by the Administrator.  [1:  An Internal Chronology contains events from a single organisation or department] 

The Case Review Administrator distributes the Internal Chronology to the various organisations whose data is required.
If an organisation needs to collect data from several departments, the recipient can forward the Internal Chronology to them and ask them to complete it rather than calling for their original records.  Anyone forwarding a document in this way is called a Local Administrator.
When the holders of the original records have completed their documents, they return them to the Administrator who wanted the information (either the Case Review Administrator or a Local Administrator). That Administrator uses Chronolator to merge them into a Composite Chronology[footnoteRef:2].  [2:  A Composite Chronology contains events from more than one organisation or department] 

There is no limit to the number of levels of Local Administration.
[image: ]	Setting Up Chronolator Documents
The diagrams below (Figure 1 on page 8 and Figure 2 on page 9) illustrate the flow of documents between administrators and data collectors. 
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	[bookmark: _Ref460921641][bookmark: _Ref460918631][bookmark: _Ref460918632][bookmark: _Toc460919036][bookmark: _Toc543530]Figure 1 - multiple levels of administration - schematic document flow
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	[bookmark: _Ref460921653][bookmark: _Ref460918633][bookmark: _Ref460918634][bookmark: _Toc460919037][bookmark: _Toc543531]Figure 2 - multiple levels of administration - a possible scenario
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[bookmark: _Toc543487]About this document
[bookmark: _Toc375841015][bookmark: _Toc375894214]This document is a guide and reference for Case Review Administrators who are going to use the Chronolator Online Workbench to create a new Internal Chronology. 
[bookmark: _Toc543488]Chronolator Documentation
Setting Up Chronolator Documents (this document) describes how to create Chronolator Documents using the Chronolator Online Workbench, and how to distribute them.
Using Chronolator Documents describes how Chronolator facilitates the production of accurate chronologies, how to combine Chronolator Documents into Composite Chronologies, and the other tools and features Chronolator provides.
Using Chronolator Samples contains some exercises you can undertake with the sample documents to acquaint yourself with the main features  of Chronolator. 
[image: ] For information about the terminology used in this document (e.g. ‘Internal Chronology’, ‘Local Administrator’), see Appendix E - Chronolator Terminology in the Using Chronolator Documents manual.
These documents can be downloaded from www.chronolator.co.uk/documentation. 
[bookmark: _Toc165364109][bookmark: _Toc375841016][bookmark: _Toc375894215][bookmark: _Toc543489]A note about Word versions and options
The illustrations in this document were mostly taken using Word 2016 with a typical set of user options; your own experience might be slightly different. Separate instructions are provided for each Word version if there are marked differences.
Chronolator documents are supplied in the docm format introduced with Word 2007. They can be opened in Word XP and 2003 if the Microsoft Office Compatibility Pack is installed. They can be saved in the old doc format if need be. 
[bookmark: _Limited_support_for][bookmark: _Toc375841017][bookmark: _Toc375894216][bookmark: _Ref375909920][bookmark: _Toc543490]Limited support for Word 2000
Word 2000 is no longer supported by Microsoft. Macros in docm files are not supported in Word 2000 even if the Compatibility Pack is installed. Word 2000 is therefore not suitable if you want to use the Chronolator Online Workbench.
If you are using Word 2000 and your administrator has sent you an Internal Chronology as a docm file, ask them to save and send you a doc version.
[bookmark: _Word_for_Apple][bookmark: _Toc375841018][bookmark: _Toc375894217][bookmark: _Ref460393565][bookmark: _Toc543491]Word for Apple Mac
[bookmark: _Toc357856844][bookmark: _Toc357858294]Chronolator is designed for and tested on Windows versions of Word. It will certainly not work with Word 2008 for Mac, as it does not include the Visual Basic for Applications programming environment used to run macros. It might run OK on other versions of Word for Mac, but it is not tested on them and support is not guaranteed. 
[bookmark: _Toc375894218][bookmark: _Toc543492]How can I tell which version of Word I am using?
The simplest way is to look at the 'splash screen'  Word displays while it starts, although this will not show any difference between Word 2013 and 2016.
	Word XP
	Word 2003
	Word 2007
	Word 2010
	Word 2013 / 2016

	[image: ]
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	[image: ]



Alternatively, type 'how can I tell which version of Word I am using' into a search engine. At the time of writing, the most useful link this revealed was on Microsoft's web site:
http://office.microsoft.com/en-gb/word-help/what-version-of-office-am-i-using-HA101873769.aspx. 


[bookmark: _Toc359744067][bookmark: _Toc375841019][bookmark: _Toc375894219][bookmark: _Toc543493]Viewing and printing this document
[bookmark: _Toc359744068][bookmark: _Toc375841020][bookmark: _Toc375894220][bookmark: _Toc543494]Conventions and Symbols
Text like this  generally denotes something on the screen that you can press.
Text like this denotes a reference to a tool or function, or is used for general emphasis.
Text like this refers to a document.
Hyperlinks to other places in the document, or to other documents, are displayed like this.
[image: ]This symbol marks a hint or tip.
 [image: ] This one marks a Warning.
[bookmark: _Toc359744069][bookmark: _Toc375841021][bookmark: _Toc375894221][bookmark: _Toc543495]Online viewing
This document is available in Word and PDF versions.
We recommend the Word version for online reading. Use the Web Layout and Navigation Pane options on the View tab to avoid unnecessary page and table breaks and give you an overview of the document headings. Clicking on one of the headings in the Navigation Pane takes you to the relevant part of the document. 
[image: ]
[bookmark: _Toc359744070][bookmark: _Toc357856845][bookmark: _Toc357858295]Hyperlinks
The document also contains hyperlinks, which are displayed like this. Click on one to go to the relevant part of the document. 
We recommend that you add the Back button to the Quick Access Toolbar (QAT) on the ribbon so that you can go back to where you came from. Follow the instructions below to see how to do this.
	Press the small arrow to the right of the QAT, and click on More Commands . . . 
	[image: ]

	Under Choose Commands From , select Commands Not in the Ribbon.
Scroll down to and press Back.
Press Add >>.
Press OK.
	[image: ]

	The Back button is added to the QAT:
	[image: ]



Now, after you have followed a hyperlink, you can use the button to go back to where it occurred.


[bookmark: _Toc375841022][bookmark: _Toc375894222][bookmark: _Toc543496]Printing 
For printing we recommend the PDF version of this document as it avoids any issues with page numbering. 
If you nevertheless want to print the Word version, note that Word resolves page references ‘on the fly’. To make sure they are correct when you print it, ensure that the relevant Word option is turned on as described below.
[bookmark: _Toc357856846][bookmark: _Toc359744072]Word 2003 and earlier
Press Tools > Options > Print and tick the Update Fields box. 

[bookmark: _Toc357856847][bookmark: _Toc359744073][image: Office 2007 logo]Word 2007 
Press   >     > Word Options > Display and tick the Update fields before printing box.

[bookmark: _Toc357856848][bookmark: _Toc359744074]Word 2010 and later
Press File > Options > Display and tick the Update fields before printing box.

[bookmark: _Toc271021949][bookmark: _Toc357856849][bookmark: _Toc359744075]All versions
	If you get a message like this, select Update Entire table and press OK.
	[image: ]


[bookmark: _Toc375894233][bookmark: _Toc543497][bookmark: _Toc375894223]Practise using Chronolator
If you want to practise using Chronolator you can use the sample files supplied with it alongside the Using Chronolator Samples document. If you do not have these you can download them from www.chronolator.co.uk/download.htm.
[bookmark: _Toc375894234][bookmark: _Toc543498]Getting Help
Chronolator provides a number of video tutorials which illustrate how to accomplish many of the tasks you need to undertake. Press Help > Tutorials on the Chronolator toolbar to see them. If they are not installed on your computer, you will be asked if you want to view them on the Web. 
[bookmark: _Toc543499]Installing Chronolator
Chronolator is written in Microsoft Office Visual Basic for Applications, which is a standard feature of Microsoft Office. All Chronolator Documents contain the Chronolator software internally, so no special installation or setup procedure is required.
Such as it is, 'installing' Chronolator is simply a matter of saving some Word documents on your system, and then (if you wish) installing a licence. 
[bookmark: _Toc375894224][bookmark: _Toc543500]System Requirements
[bookmark: _Toc375894225][bookmark: _Toc543501]Microsoft Word
Chronolator works with all versions of Word for Windows from XP up, including 64 bit versions where available.
See Limited support for Word 2000 on page 10 for information about Word 2000.
See Word for Apple Mac on page 10 for information about Word for Mac.

[bookmark: _Toc375894226][bookmark: _Toc543502]Downloading and installing the Online Workbench
The Chronolator Online Workbench  (ChronolatorOnlineWorkbench.docm) is used to create the Chronolator Documents you send to agencies for completion.
Instructions about how to download and install it and its related documents are at www.chronolator.co.uk/download.htm. 
[bookmark: _Toc375894227][bookmark: _Toc543503]Distributed Chronolator Documents
People who receive the Chronolator Documents you create do not need to install any software programs. They merely need to have one of the above versions of Microsoft Word.
[bookmark: _Toc375894228][bookmark: _Toc543504]Licensing
Chronolator is licensed software. You can evaluate its features without having a licence, but the Chronologies it creates include a watermark on every page. If you do not want these watermarks to appear, your Chronolator Document must be licensed. 
When you buy a licence to use the Chronolator Online Workbench, you are given a small file whose name begins Chronolator34Licence. To install it, simply copy it into the same folder as the Online Workbench. The Online Workbench propagates the licence information into the Chronolator Documents it creates. 
Details about how to get a licence for the Online Workbench can be found on the Chronolator Web site at .
[bookmark: _Using_ChronoLator_–_2][bookmark: _the_ChronoLator_process][bookmark: _Toc78869945][bookmark: _Ref80153870][bookmark: _Ref165178121][bookmark: _Toc375894229][bookmark: _Toc543505]The Chronolator Process – an Overview
This section provides an overview of the main tasks involved in producing a chronology with Chronolator. Later sections provide more detail about each task.
Chronolator adds data checking and manipulation capabilities to a document containing Word tables. 
The main steps in using it are as follows:
Create a blank Internal Chronology document (see Creating a new Internal Chronology Document on page 18);
Distribute the Internal Chronology document to the participating agencies so they can input their own data (see Distributing the Internal Chronology Document on page 30);
Collate the completed Chronology Documents and produce the final Composite Chronology document (see Creating a Composite Chronology Document in the Using Chronolator Documents manual).
If Chronolator encounters a problem, it issues a message. Details of these messages can be found in Appendix B - Chronolator Messages in the Using Chronolator Documents manual).
[bookmark: _Toc78869946]For information about the terminology used in this document (e.g. ‘Internal Chronology’, ‘Local Administrator’), see Appendix E - Chronolator Terminology in the Using Chronolator Documents manual.
[bookmark: _Toc375894230][bookmark: _Toc543506]Create a blank Internal Chronology document
[bookmark: _Toc78869947]When a major investigation is about to begin, you must decide what information needs to be collected and under what table headings. Often this decision will be made for you by a Review Panel or similar body.
You create a new Internal Chronology document by using the Chronolator Online Workbench. The principal component of the Internal Chronology is a table with all the required headings, but it can also contain a preamble - for example, an explanation of what the case is about and what sort of information is required.
See Creating a new Internal Chronology Document on page 18 for details.
[bookmark: _Toc375894231][bookmark: _Toc543507]Distribute the Internal Chronology document
[bookmark: _Toc78869948]When you have created the Internal Chronology document, you circulate copies of it to the agencies who need to contribute information to the investigation. Any convenient medium can be used for distribution: email or CD for example.
If the document is confidential, you can protect it in several ways:
If sending it by physical means, use Royal Mail Signed For or another secure service;
If sending electronically, consider using Word’s standard password protection features  (see Protecting a document with a password on page 30) and sending the password separately.
[bookmark: _Toc375894232][bookmark: _Toc543508]Collate the completed Chronology documents into the Composite Chronology document
[bookmark: _Creating_a_new][bookmark: _Ref72554558][bookmark: _Toc78869949]As people complete the Internal Chronology, Chronolator ensures that information which you have deemed mandatory is indeed entered. Documents are automatically checked for correct sequence of dates and times. Incomplete or invalid information is highlighted and the user is prompted to make any necessary corrections. 
You can begin compiling the Composite Chronology document as soon as completed chronologies start to come back. There is no need to wait until they have all been returned. 
Chronolator helps you maintain an audit trail of which Internal Chronologies provided the information in a Composite Chronology. You say how you want to identify the Internal Chronology you are importing (for example, Berrickshire Police), and Chronolator adds that identification to the Source of Information column in the Composite Chronology.
As the agencies’ chronologies are imported and merged, you use Chronolator to sort the composite table by date and time and to translate the dates and times from the various agencies into a consistent format.
Finally, you can use standard Word features to add any additional formatting desired.
Creating Composite Chronologies is described in Creating a Composite Chronology Document in the Using Chronolator Documents manual.
[bookmark: _Creating_a_new_1][bookmark: _Ref165281994][bookmark: _Toc375894235][bookmark: _Toc543509]Creating a new Internal Chronology Document
[bookmark: _Toc375894236][bookmark: _Toc543510][bookmark: _Toc78869950]Overview
Creating a new Internal Chronology document involves the following steps:
Decide what column headings you want to appear in the table;
Decide which columns must always be completed, and which can be left blank;
Decide how much information you want to use to identify each event in the chronology. Do you just want the date on which it happened, or also the time, and possibly the date and time it finished?
Open the Chronolator Online Workbench and follow the steps shown in the Step by Step guide on page 20.
[bookmark: _Toc78869952][bookmark: _Toc375894237][bookmark: _Toc543511]Special Columns
[bookmark: _Ref72120029]Chronolator treats most of the columns in a chronology table as free-form text, only checking them if you deem them mandatory. However, some columns play a major role in the way a Chronolator Document is processed. 
These special columns are briefly described below. You define which ones you want in a document. 
[image: ]Chronolator's names for them are in bold type, but you can give them different headings in the chronology table.
[bookmark: _Toc357856865][bookmark: _Toc358443201][bookmark: _Toc375894238][bookmark: _Toc543512]Event order: Date,  Time and Sequence columns
Up to five special columns can be used to specify when an event happened: 
Sequence (optional)
Start Date (mandatory for all Chronolator Documents)
Start Time (optional)
End Date (optional)
End Time (optional)
Chronolator can automatically populate the Sequence column with event reference numbers. It can also be used to specify the order of events on a particular day when their times are unknown.
When Chronolator checks a Chronology Document, it ensures that anything in a Date or Time column is a valid date or time, and that all the events are in order (either ascending or descending).


For ease of input, dates can be entered in a variety of formats. For example, all the following will be recognised:
22.05.16
22-may-16
22/05/16
22/05/2016
Many mistyped dates can also be recognised, e.g. 22.05/16.
Sometimes people might not know exactly when an event occurred. You should decide how you want them to deal with this, as Chronolator will expect a valid date or time to be provided (for example, ? 22 may 2016 or probably 22 may 2016 would not be allowed). One possibility is for them to enter their best estimate and to note that they have done so in another column. The same considerations might apply if they want to enter a range of dates but you have not provided an End Date column.
[bookmark: _Toc357856866][bookmark: _Toc358443206][bookmark: _Toc375894239][bookmark: _Toc543513]Source of Information column
It is vital that the source of information about an event is noted. The Source of Information column is therefore mandatory in all Chronolator Documents. It is the first one after the event ordering columns.
To make it easier for people to complete their information, there is no need for them to say what organisation they work for in this column.
For example, suppose someone who works for the Berrick New Town Clinic is entering data from a Health Visitor’s notes. They need only to record the source of information simply as, say, Health Visitor HV1 diary, not as Berrick New Town Clinic Health Visitor HV1 diary. 
When you merge their chronology into a Composite Chronology, Chronolator adds the fact that the information is from Berrick New Town Clinic to the Source of Information column. 

	For example, if the clinic’s document contains this entry . . .

	[image: ]

	. . . after you have imported it, the entry will look like this:

	[image: ]


[bookmark: _Toc357856867][bookmark: _Toc358443207][bookmark: _Toc375894240]

[bookmark: _Toc543514]Glossary column
A Glossary column can be included which should contain only defined abbreviations - for example, somebody's initials. This can be useful when a chronology contains information pertaining to more than one person. Chronolator will check that anything in this column has been defined in the Abbreviations Glossary. 
[bookmark: _Toc78869956][bookmark: _Toc375894241][bookmark: _Toc543515][bookmark: _Toc78869951]‘Must Fill’ columns
You might want to ensure that a particular column is always completed for every event. You can do this when setting up the new Internal Chronology document by ticking its Must Fill box in the Case Details Wizard.
The Start Date and Source of Information columns are always ‘Must Fill’ columns. Whether the other special columns are is up to you.
[bookmark: _Toc375894242][bookmark: _Toc543516]Chronolator default Columns and headings
By default, Chronolator creates a table with the following headings, which are based on those recommended by the London Safeguarding Children Board[footnoteRef:3]: [3:  London Child Protection Procedures, Edition 4, p510 (London Safeguarding Children Board, 2010 (www.londonscb.gov.uk))] 


	[image: ]



The only special columns in the default table are the Start Date, Start Time, and Source of Information columns. As you can see, you can choose whatever you like for their headings: the Start Date and Start Time columns in the default table are simply headed Date and Time.
[bookmark: _Step_by_step][bookmark: _Ref72121922][bookmark: _Toc78869957][bookmark: _Toc375894243][bookmark: _Toc543517][bookmark: _Ref72554613][bookmark: _Toc78869958]Step by Step guide
[bookmark: _Toc375894244][bookmark: _Toc543518]Open the Workbench
Open ChronolatorOnlineWorkbench.docm.
Macros and the Online Workbench toolbar
Chronolator works by using Word macros. Because they are computer programs, macros can be used to propagate and run computer viruses. Word therefore allows you to prevent them running, since for most documents they are unnecessary. However, for Chronolator they are essential. 

	If macros are allowed to run, Chronolator will ask you to confirm that you accept the terms of its Licence:
	[image: ]



If that does not happen, please refer to the information about macros in  Using Chronolator Documents.
After you press OK  to accept the licence terms, the Online Workbench toolbar will be added to Word.
	In Word 2007 and later versions, it is added to any other custom toolbars on the Ribbon’s Add-Ins tab. 
	[image: ]

	In Word 2003 and earlier versions, it is added underneath your other toolbars. 
	[image: ]





[bookmark: _Toc375894245][bookmark: _Toc543519]Complete the Case Details Wizard 
	Click the New Internal Chronology button on the Chronolator toolbar:
	[image: ]


	The Case Details Wizard appears:
	[image: ]



About the Case Details Wizard
There are four main things to know about the Case Details Wizard:
it has several tabs along the top, each of which enables you to set up a different aspect of the Internal Chronology;
you can move from one tab to another by using the buttons at the bottom of the Wizard, or by clicking on the tab itself;
every tab has a panel on the left describing its purpose;
the Finish button is only enabled when you are viewing the Summary tab.
[image: ]The panel on the left of each tab will usually give you enough information to proceed. If not, you can find more about the tab in the following parts of this document.


Model Tab
	Using a Model lets you set all of a chronology’s features in one go. The fastest way to set up a Chronolator Document is to choose a suitable model, click the Summary tab, and press Finish. 
[image: ]You can use Chronolator’s default headings as a model, or those in an existing Chronolator document. 

	[image: ]


When you have chosen a model, use the other tabs to change individual aspects of the document. 
If you make a lot of changes and then decide you do not want them, come back to the Model tab and press the Reset button to discard them and reload the model. 
If you choose the wrong model by mistake, use the Model tab to choose a different one.
Case Reference Tab
	If you are running several reviews at the same time it can be difficult to keep track of all the individual chronologies you receive. Giving each case a unique Case Reference helps prevent you from accidentally merging chronologies from different cases. If you try to do so, Chronolator will warn you about it.

	[image: ]


The Case Reference is not displayed in the document itself.
Chronolator tries to ensure every case reference is unique by setting it to the date and time you started the Case Details Wizard. However, you can change it to whatever you want.

Sequencing and Source Tab
	This is where you set the headings describing when an event occurred, and where the information about it came from.
As a minimum, Chronolator requires that every event has a Start Date and Source of Information; the relevant boxes are ticked and cannot be un-ticked. 

	[image: ]



[image: ]You can set the text displayed in the column headings. In the example above, the Start Date column will actually be headed Date.
If you want to include any other event ordering columns, tick the appropriate box and enter some text for their headings. 
If you want a column always to be completed, tick its Must Fill box. 
[image: ]Chronolator defaults to having an optional Start Time column (its Must Fill box is not ticked). Without a Start Time column, if people want to enter a time they generally try to put it  in the next most relevant column , which is the Date one - and Chronolator then flags the date as an error. 


General Headings Tab
	You can specify up to eight general headings for each event, but you should remember that the more columns you have, the more cramped the table will be, even though it is presented in Landscape format. 
To add a new heading, type it in the box at the bottom and press Add.
To change where a column appears, click on it and use the up or down arrow buttons.
To delete a heading, click on it and press Delete.
	[image: ]



Must-Fill Columns Tab
	When you want a particular column always to be completed, tick the box against it on this tab.
In this example, the Response or Outcome column has to be completed for every event.
	[image: ]




Abbreviations Tab

	A Chronolator Document can contain an Abbreviations Glossary. Each abbreviation can be up to ten characters long, and its definition up to thirty. 

	[image: ]


People can see the abbreviations you define, and can add and delete their own by using the Admin > Abbreviations button on the Internal or Composite Chronology toolbar. They cannot delete abbreviations you have defined.
How you use the glossary is up to you. It can just be an information repository for reference and recommendation, or it can be included in Chronolator error checking by including a Glossary column. It can also be used by the Anonymisation and Personalisation feature, and by a reviewer who wants to navigate through a document finding people of interest.
Using a Glossary column
If you want to make sure that any abbreviations an agency uses are defined in the glossary, you create a Glossary column by ticking the Check Glossary box and entering a column heading. As with any column, you can say whether or not it has to be filled by ticking the Must Fill  box.
[image: ]Abbreviations used in other columns are not checked by Chronolator, though they do participate in Anonymisation and Personalisation.
As an example, consider a case involving several family members. You want every event in the chronology to include information about which members were involved.
You would define their initials in the glossary and provide a Glossary column. In the screenshot of the Abbreviations Tab above, abbreviations have been defined for various relationships (Younger brother, Father), organisations (Department for Education, Clinical Commissioning Group), and an individual (Tony Sedgefield). Because Check Glossary is ticked and Column Heading is completed, Chronolator will create a column headed Inits. As Must Fill is ticked, it must always be filled. Chronolator will check that it only contains abbreviations defined in the glossary. 


User-defined glossary entries
Agencies might also want to identify their personnel in an anonymous way - HV1 for a Health Visitor called Marion West for example. They can add their own abbreviations to the glossary as they complete a Chronolator Document. 
[image: ]When Chronolator merges chronologies, it keeps track of where each abbreviation was defined.
Anonymisation and Personalisation
The Abbreviations Glossary is also used to Anonymise and Personalise a document, and to navigate through a document finding people of interest. See Anonymisation and Personalisation in the Using Chronolator Documents manual for details.

Summary Tab

	[image: ]



When you have entered all the details you want, click on the Summary tab to see exactly what you have defined. If you need to make any changes, use the appropriate tab and then come back to the Summary tab for a final check. 
When everything is OK, press the Finish button.


[bookmark: _Toc375894246][bookmark: _Toc543520]Save the document
	When you press the Finish button in the Case Details Wizard, Chronolator creates an Internal Chronology to your specifications and asks you where to save it and what to call it.
Choose a suitable location and file name and press Save.
	[image: ]



Sending by email
In recent years some email systems (notably the NHS in the UK) have blocked the .docm file type that is the default used by Chronolator. You can avoid this problem by saving a document with the .doc file type; do this by changing Word Macro-Enabled Document in the above Save As dialog  to Word 97-2003 document(*.doc). 

Update the preamble
After the new Internal Chronology is saved, Chronolator opens it so you can edit the preamble.
The preamble is above the chronology table. It describes the document, says who it should be returned to, and provides some information about Chronolator.
[image: ][image: ]Chronolator does not check or process the preamble in any way; you can put whatever you want in it, or even delete it. For example, if you intend to distribute the Internal Chronology to the various agencies by email, you could include the preamble in the email and attach an Internal Chronology containing only the table. It is up to you.

[image: ]It makes sense to tell people how you expect each column to be used. Chronolator generates a What to put in the table section in the preamble describing each column, including any information about what checks Chronolator will make. You can update this table with any information or instructions you like. 

Final checks
[image: ]Make sure the table column headings are exactly what you want and have no typos. If you need to change them, do not do so in this document, but go back to the Online Workbench and create another Internal Chronology using this document as a model. 
Before you send out the document, close and re-open it, and press the Check Tables button on its Chronolator toolbar. There should be no problems, but if there are it is better that you find and fix them now rather than have your recipients all complaining to you!

[bookmark: _Distributing_the_Internal][bookmark: _Ref165282788][bookmark: _Toc375894247]Changing the preamble template
You can make permanent changes to the preamble template if you want - for example, to put your own contact details in it. The preamble template is ChronolatorMasterChronology.docm, a Word document in the same folder as the Online Workbench. You can edit it and save your changes; but before you make any changes to it, it would be sensible to save a copy somewhere in case of mistakes!

[bookmark: _Distributing_the_Internal_1][bookmark: _Ref378330755][bookmark: _Toc543521]Distributing the Internal Chronology Document
An Internal Chronology document can be distributed just like any other Word document. Most organisations do so by email, but CDs, USB sticks, file sharing sites are all valid methods of distribution.
As an Internal Chronology includes all the program code required to run the various tools and features of Chronolator. It also includes information about the Chronolator licence. You should NOT distribute your Online Workbench licence file to other agencies.
If the document is confidential, you can protect it in several ways:
Use your organisation's standard policy for such emails;
If sending it by physical means, use Royal Mail Signed For or another secure service;
If sending electronically, consider using Word’s standard password protection features - see Protecting a document with a password below. 
Along with the Internal Chronology you should also distribute some instructions about how to use it. At the very least, you should explain that the document contains macros and might produce a warning message about them when it is opened, or even prevent them from running. You might like to use the text in the Sample Covering Email / Letter on page 34.
[bookmark: _Toc80075176]The Using Chronolator Documents manual explains about macros and provides some hints and tips about working with Word tables. It also explains how a Local Administrator can distribute the Internal Chronology to a number of people and merge their input into a Composite Chronology to be returned to you. You can distribute it as-is along with the Internal Chronology document, or you may include parts of it in your own documentation package so long as you include a suitable acknowledgement of its source.
[bookmark: _Protecting_a_document][bookmark: _Toc375894248][bookmark: _Ref375910470][bookmark: _Toc543522]Protecting a document with a password
Word can protect your document with a password. Consult Word Help for full details, but here are the first steps for Word 2007, Word 2010 and Word 2013 / 2016 respectively.
[bookmark: _Toc375894249][bookmark: _Toc543523]Password Protection in Word 2007
	[image: ]Press              > Prepare > Encrypt Document
	[image: ]



[bookmark: _Toc375894250][bookmark: _Toc543524]Password Protection in Word 2010
	Press  File > Info > Protect Document > Encrypt with Password
	[image: ]


[bookmark: _Toc375894251][bookmark: _Toc543525]Password Protection in Word 2013 and Word 2016
	Press the File tab on the Ribbon. On the resulting Info  display, press  
Protect Document > Encrypt with Password
	[image: ]


[bookmark: _Toc375894252][bookmark: _Toc543526]Password protection - an alternative method for all Word versions
	In all Word versions, you can also password-protect a document using the Tools > General Options dropdown on the Save As dialog:

	[image: ]


[bookmark: _Toc375894253][bookmark: _Toc543527]Completing Internal Chronology documents
As a Case Review Administrator, you might not be particularly involved in entering data in the Chronolator Documents you create. However, as you might be asked about them it will be useful for you to know how they work and what they do. Details can be found in the Using Chronolator Documents manual. 
One significant benefit of Chronolator which is described there is that a Local Administrator can distribute an Internal Chronology to a number of people and merge their input into a Local Composite Chronology to be returned to you.
The flowcharts in Figure 1 - multiple levels of administration - schematic document flow on page 8 and in Figure 2 - multiple levels of administration - a possible scenario on page 9 illustrate the flow of documents between administrators and data collectors.
[bookmark: _Creating_a_Composite][bookmark: _Toc78869959][bookmark: _Ref86645669][bookmark: _Toc375894254][bookmark: _Toc543528][bookmark: _Ref72554645]Creating a Composite Chronology document

	Start a new Composite Chronology by pressing the New Composite Chronology button on the Chronolator toolbar:
	[image: ]



The rest of the process is described in Creating a Composite Chronology Document in the Using Chronolator Documents manual.
[bookmark: _Sample_Covering_Email][bookmark: ap_e][bookmark: _Toc375894255][bookmark: _Toc543529]Sample Covering Email / Letter
Please find attached the Serious Case Review document as discussed at the recent panel meeting.
It is a special Word document which has been produced using Chronolator, the Chronology Tool.  The first thing you should do is to save it in a suitable place on your computer or network. 
Tutorial
If you would like to watch a brief tutorial about using Chronolator, please go to the Web page at www.chronolator.co.uk/tutorials/quickstart01-chronology-recipient. 
Macros and the Chronolator Toolbar
Chronolator uses Word ‘macros’, and if you are prompted about them when you open the document you should ensure you allow them to run. 
When you do, Chronolator will create a toolbar on the Add-Ins tab of the Word Ribbon (or underneath your usual Word toolbars if you are using Word 2003 or earlier). 
If the toolbar does not appear, please check Appendix A in UsingChronolatorDocuments for possible causes. You should have been sent a copy of it along with this document; if not, please contact me.
If for some reason you cannot enable macros, you can still update the document but you will not be able to use basic Word Save (you will get a message about macros being disabled). In that case, you should save your changes either:
· by using Save As, or
· by closing the document and making the relevant reply when Word asks you if you want to save changes.
What to put in the table
The first pages of the Chronolator document give you background to the case and instructions about what details to enter in the table and where to put them.
The table itself is pre-set with the columns agreed by the Case Review panel.  Fill in the cells in the usual way using Word.
The document is a Word document, so you can change the font, the column widths, the shading and other cosmetic formatting, but you must not add or remove columns or change the column headings as Chronolator will be unable to check and process the table. If you do so by accident, you can create a suitable blank table at the end of the document by pressing Admin > New Table on the Chronolator toolbar.
Entering events
You can enter events as the records come to hand, and use the Sort Tables button on the Chronolator toolbar to put them in date order. You can enter dates and times as they appear on the original records, and use the Format Dates button to put them into a consistent format.
Error checking
Every time you  close the document, Chronolator will check that the table conforms to the specifications made by the Case Review Administrator, and that it is in chronological order.
All problems are flagged with the symbol . Non-blank invalid entries are highlighted in turquoise, and dates and times of out-of-sequence events are highlighted in yellow. If you rest your mouse on the , a description of the error is displayed. A full list of errors is also created at the end of the document. You can scroll from one to another using the video-like buttons on the Chronolator toolbar.
CAUTION: Do not write anything after the error list as it will be deleted the next time Chronolator checks the document.
Please ensure that all errors are corrected before returning this document.
You can get Chronolator to check the table at any time by pressing the Check Tables button, and it also has many other features which you might find useful.

Combining a number of individual chronologies from your agency
If you want to devolve responsibility for data collection to a number of other people, you can forward this document to them and then use Chronolator to merge their individual chronologies. Using Chronolator Documents contains information about this and other features, together with some useful general tips about using Microsoft Word tables. 
Finding out more about Chronolator
Further information about Chronolator can be found in UsingChronolatorDocuments, which also contains some useful tips about working with Word tables. There is also a set of video tutorials at www.chronolator.co.uk/tutorials.
If you wish to devolve responsibility for collecting the requested data, you can forward the document to other people to complete, and then use Chronolator to merge their results into a single table to return to me.  The attached document UsingChronolatorDocuments describes how to do this.
If you have any problems please contact Marion West@berrick-LSCB.gov.uk who will be able to advise you. 
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